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Preface
This guide explains the integration between Service Desk and 
VantagePoint Operations for Windows and UNIX. With the 
information in this guide you can install, configure and perform the 
various tasks available with this integration. 

This guide is intended for IT administrators who will install and 
configure the integration, and for users who will perform the integration 
tasks. 

To install and configure the integration you must have knowledge of both 
the VantagePoint Operations application and Service Desk.

This guide is organized as follows:

• Chapter 1, “Introduction,” on page 25 describes the architecture of the 
VantagePoint Operation Integration and gives a brief explanation of 
what the integration possibilities are.

• Chapter 2, “Installation,” on page 31 describes the installation steps 
that need to be performed on Service Desk and on your VantagePoint 
server.

• Chapter 3, “VPO for Windows and Service Desk Configuration,” on 
page 45 explains how to configure the integration if you are using 
VantagePoint for Windows.

• Chapter 4, “VP UNIX and Service Desk Configuration,” on page 75 
explains how to configure the integration if you are using a 
VantagePoint for Unix application with Service Desk.

• Chapter 5, “User Tasks,” on page 107 provides examples on how to 
use the different features supplied with this integration.

• Chapter 6, “Troubleshooting,” on page 125 contains information on 
the default locations of installed files and other information that may 
be helpful in solving problems with the integration.
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Revision History

When an edition of a manual is issued with a software release, it has 
been reviewed and tested and is therefore considered correct at the date 
of publication. However, errors in the software or documentation that 
were unknown at the time of release, or important new developments, 
may necessitate the release of a service pack that includes revised 
documentation. Revised documentation may also be published on the 
Internet, see “We Welcome Your Comments!” in this preface for the URL. 

A revised edition will display change bars in the left-hand margin to 
indicate revised text. These change bars will only mark the text that has 
been edited or inserted since the previous edition or revised edition.

When a revised edition of this document is published, the latest revised 
edition nullifies all previous editions.

Table 1 Revision History

Edition and Revision 
Number

Issue Date Product Release

First Edition August, 2001 Service Desk 4.0
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Related Publications
This section helps you find information that is related to the information 
in this guide. It gives an overview of the Service Desk documentation and 
lists other publications you may need to refer to when using this guide.

The Service Desk Documentation
Service Desk provides a selection of books and online help to assist you in 
using Service Desk and improve your understanding of the underlying 
concepts. This section illustrates what information is available and 
where you can find it.

NOTE This section lists the publications provided with Service Desk 4.0. 
Updates of publications and additional publications may be provided in 
later service packs. For an overview of the documentation provided in 
service packs, please refer to the readme file of the latest service pack. 
The service packs and the latest versions of publications are available on 
the Internet. See the section “We Welcome Your Comments!” in this 
preface for the URLs.

• The Readme.htm file on the Service Desk CD-ROM contains 
information that will help you get started with Service Desk. It also 
contains any last-minute information that became available after the 
other documentation went to manufacturing. 

• The HP OpenView Service Desk: Release Notes give a description of 
the features that Service Desk provides. In addition, they give 
information that helps you:

— compare the current software’s features with those available in 
previous versions of the software;

— solve known problems.

The Release Notes are available as a PDF file on the HP OpenView 
Service Desk 4.0 CD-ROM. The file name is Release_Notes.pdf.

• The HP OpenView Service Desk: User’s Guide introduces you to the 
key concepts behind Service Desk. It gives an overview of what you 
can do with Service Desk and explains typical tasks of different types 
of Service Desk users. Scenario descriptions are provided as examples 
of how the described features could be implemented.
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The User’s Guide is available as a PDF file on the HP OpenView 
Service Desk 4.0 CD-ROM. The file name is User’s_Guide.pdf .

• The HP OpenView Service Desk: Supported Platforms List contains 
information that helps you determine software requirements. It lists 
the software versions supported by Hewlett-Packard for Service Desk 
4.0.

The Supported Platforms List is available as a PDF file on the HP 
OpenView Service Desk 4.0 CD-ROM. The file name is 
Supported_Platforms_List.pdf.

• The HP OpenView Service Desk: Installation Guide covers all aspects 
of installing Service Desk.

The Installation Guide is available as a PDF file on the HP OpenView 
Service Desk 4.0 CD-ROM. The file name is 
Installation_Guide.pdf.

• The HP OpenView Service Desk: Administrator’s Guide provides 
information that helps application administrators to set up and 
maintain the Service Desk application server for client usability. 

The Administrator’s Guide is available as a PDF file on the HP 
OpenView Service Desk 4.0 CD-ROM. The file name is 
Administrator’s_Guide.pdf .

• The HP OpenView Service Desk: Data Exchange Administrator’s 
Guide explains the underlying concepts of the data exchange process 
and gives instructions on exporting data from external applications 
and importing it into Service Desk. The data exchange process 
includes importing single service events and batches of data. 

The Data Exchange Administrator’s Guide is available as a PDF file 
on the HP OpenView Service Desk 4.0 CD-ROM. The file name is 
Data_Exchange.pdf.

• The HP OpenView Service Desk: VantagePoint Operation Integration 
Administrator’s Guide explains the integration between Service Desk 
and VantagePoint for Windows and UNIX. This guide covers the 
installation and configuration of the integration and explains how to 
perform the various tasks available with the integration. 

The VantagePoint Operation Integration Administrator’s Guide is 
available as a PDF file on the HP OpenView Service Desk 4.0 
CD-ROM. The file name is VPO_Integration_AG.pdf.

• The HP OpenView Service Desk: Migration Guide provides a detailed 
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overview of the migration from ITSM 5.7 to Service Desk 4.0, to 
include an analysis of the differences in the two applications. Detailed 
instructions in this guide lead through the installation, configuration 
and other tasks required for a successful migration. 

The Migration Guide is available as a PDF file on the HP OpenView 
Service Desk 4.0 CD-ROM. The file name is Migration_Guide.pdf.

• The HP OpenView Service Desk: API Programmer’s Guide contains 
information that will help you create customized integrations with 
Service Desk. This guide depicts the API structure, and explains 
some of the basic functions with examples for using the Application 
Programming Interface (API) provided with Service Desk. The API 
extends the HP OpenView Service Desk environment by providing 
independent programmatic access to data-centered functionality in 
the Service Desk application server environment.

The API Guide is available as a PDF file on the HP OpenView Service 
Desk 4.0 CD-ROM. The file name is API_pg.pdf.

• The HP OpenView Service Desk: Web API Programmer’s Guide 
contains information that will help you create customized 
integrations with Service Desk using the Service Desk Web API. This 
API is particularly suited for developing Web applications. 

The Web API Programmer’s Guide is available as a PDF file on the 
HP OpenView Service Desk 4.0 CD-ROM. The file name is 
Web_API_pg.pdf.

• The HP OpenView Service Desk: Data Dictionary contains helpful 
information about the structure of the application.

The Data Dictionary is available as an HTML file on the HP 
OpenView Service Desk 4.0 CD-ROM. The file name is 
Data_Dictionary.htm.

• The HP OpenView Service Desk 4.0 Computer Based Training (CBT) 
CD-ROM is intended to assist you in learning about the functionality 
of HP OpenView Service Desk 4.0 from both a user and a system 
administrator perspective. The CD-ROM contains demonstration 
videos and accompanying texts that explain and show how to perform 
a wide variety of tasks within the application. The CBT also explains 
the basic concepts of the Service Desk application. 

The HP OpenView Service Desk 4.0 Computer Based Training (CBT) 
CD-ROM will be shipped automatically with the regular Service Desk 
software. The CBT will be available for shipment shortly after the 
  19



release of the Service Desk software.

• The online help is an extensive information system providing:

— procedural information to help you perform tasks, whether you 
are a novice or an experienced user;

— background and overview information to help you improve your 
understanding of the underlying concepts and structure of Service 
Desk;

— information about error messages that may appear when working 
with Service Desk, together with information on solving these 
errors;

— help on help to learn more about the online help.

The online help is automatically installed as part of the Service Desk 
application and can be invoked from within Service Desk. See the 
following section entitled “Using the Online Help” for more 
information.

Reading PDF Files
You can view and print the PDF files with Adobe Acrobat Reader. 
This software is included on the HP OpenView Service Desk 4.0 
CD-ROM. For installation instructions, see the readme.htm file on the 
CD-ROM.

The latest version of Adobe Acrobat Reader is also freely available from 
Adobe’s Internet site at http://www.adobe.com.

Using the Online Help
You can invoke help from within Service Desk in the following ways:

• To get help for the window or dialog box you are working in, do one of 
the following:

— Press F1.

— Click the help toolbar button .

— Choose Help from the Help menu.

— Click the help command button  in a dialog box. 

• To search for help on a specific subject using the table of contents or 
the index of the help system: choose Help Contents & Index from 
the Help menu.
   20
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When you are in the help viewer, you can find help on how to use the help 
system itself by clicking the Help toolbar button:

Service Desk also provides tooltips and “What’s This?” help for screen 
items like buttons, boxes, and menus.

A tooltip is a short description of a screen item. To view a tooltip, rest the 
mouse pointer on the screen item. The tooltip will appear at the position 
of the mouse pointer.

“What’s This?” help is a brief explanation of how to use a screen item. 
“What’s This?” help generally gives more information than tooltips. To 
view “What’s This?” help:

1. First activate the “What’s This?” mouse pointer in one of the following 
ways:

• Press Shift+F1.

• Click the “What’s This?” toolbar button .

• Choose What’s This?  from the Help  menu.

• In dialog boxes, click the question mark button  in the title bar. 

The mouse pointer changes to a “What’s This?” mouse pointer .

2. Then click the screen item for which you want information. The 
“What’s This?” help information appears in a pop-up window.

To close the pop-up window, click anywhere on the screen or press any 
key on your keyboard.

Other Related Publications
In addition to the Service Desk documentation mentioned above, you 
may want to refer to the following publications when using this guide:

• HP OpenView VantagePoint Operation for UNIX: Concepts Guide

• HP OpenView VantagePoint for Windows: Concepts Guide

• HP OpenView VantagePoint for Windows: Installation and 
Administrative Task Guide

• HP OpenView VantagePoint Operation for UNIX Developer’s Toolkit: 
Application Integration Guide
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Typographic Conventions
The table below illustrates the typographic conventions used in this 
guide.

Font What the Font Represents Example

Italic References to book titles See also the HP OpenView Service 
Desk: Installation Guide.

Emphasized text Do not delete the System user.

Bold First-time use of a term that is 
explained in the glossary

The service call is the basis for 
incident registration.

Courier Menu names You can adjust the data view with 
the commands in the View menu.

Menu commands Choose Save from the menu.

Button names Click Add to open the Add Service 
Call dialog box.

File names To start the installation, 
double-click setup.htm.

Computer-generated output, such 
as command lines and program 
listings

If the system displays the text
C:\>dir a:
The device is not ready
then check if the disk is placed in 
the disk drive.

Courier bold User input: text that you must 
enter in a box or after a command 
line

If the service call must be solved 
within 30 minutes, enter 30.

Courier italic Replaceable text: text that you 
must replace by the text that is 
appropriate for your situation

Go to the folder X:\\Setup, where 
X is your CD-ROM drive.
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Helvetica bold Keyboard keys

A plus sign (+) means you must 
press the first key (Ctrl in the 
example), hold it, and then press 
the second key (F1 in the 
example).

Press Ctrl+F1.

Font What the Font Represents Example
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We Welcome Your Comments!
Your comments and suggestions help us understand your needs, and 
better meet them. We are interested in what you think of this manual 
and invite you to alert us to problems or suggest improvements. You can 
submit your comments through the Internet, using the HP OpenView 
Documentation Comments Web site at the following URL:

http://ovweb.external.hp.com/lpe/comm_serv

If you encounter errors that impair your ability to use the product, please 
contact the HP Response Center or your support representative.

The latest versions of OpenView product manuals, including Service 
Desk manuals, are available on the HP OpenView Manuals Web site at 
the following URL:

http://ovweb.external.hp.com/lpe/doc_serv

Software patches and documentation updates that occur after a product 
release, will be available on the HP OpenView Software Patches Web site 
at the following URL:

http://support.openview.hp.com/cpe/patches
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1 Introduction

The VantagePoint Operations Integration includes a variety of different 
integration options. This chapter provides a brief explanation of the 
architecture and the integration options available.
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The Architecture
The VantagePoint Operation integration is available for VantagePoint 
for Windows and VantagePoint Operations for UNIX. The following 
diagrams show the architecture for each and how the integration 
possibilities fit into the architecture.

Figure 1-1 VantagePoint for Windows Architecture
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Figure 1-2 VantagePoint for UNIX Architecture
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Integration Possibilities
The Service Desk integration with VantagePoint makes it possible to:

• Import nodes and services into Service Desk.

• Send events from VantagePoint to Service Desk.

• Reflect VantagePoint updates in Service Desk.

• Manually forward events to Service Desk.

• Send acknowledgment messages and message annotations from 
Service Desk to VantagePoint.

• View Service Desk configuration items from VantagePoint 

• View VantagePoint service state from a browser.

• Generate a VantagePoint message from Service Desk.

• Monitor Service Desk processes and error log files.

• Suppress node-down messages in VantagePoint.

Importing Nodes and Services into Service Desk

This feature will work with VantagePoint for Windows or UNIX. Node 
information from VantagePoint can be extracted and imported into 
Service Desk as configuration items. Data Exchange tasks are supplied a 
configurable extractor and import mapping with default settings. 

There are separate Data Exchange Tasks for UNIX and Windows users. 
Both require an ODBC link to your Oracle database. For more 
information see, “Importing Nodes into Service Desk” on page  108.

Sending Events From VantagePoint

This feature is available for VantagePoint for Windows and for UNIX. 
VantagePoint for Windows users can send event information to Service 
Desk using a WMI policy that intercepts OV_Messages and uses a Visual 
Basic script called Vpw-Sd.vbs to call sd_event and forward attributes 
to Service Desk. SD_event creates a corresponding incident in Service 
Desk. 

VantagePoint for UNIX users can send event information to Service Desk 
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using the Trouble Ticket interface to call sd_eventins.sh. 

For more information see “Sending Events From VantagePoint” on page  
110.

Reflecting Updates Done in VantagePoint

Currently this feature is only available with VantagePoint for Windows. 
Changes made to VantagePoint messages from the VantagePoint 
management console or the API will be reflected in Service Desk. A WMI 
policy that registers the event class OV_Message_ChangeEvent is used. 
When a message change occurs, for example severity change or message 
text change, the sd_event program in Service Desk will be called to 
update the corresponding incident. See “Reflecting Updates Done in 
VantagePoint” on page  112 for more information.

Manually Forward Events To Service Desk

This feature is currently only available on VantagePoint for UNIX. You 
can manually register an incident in Service Desk , by using the Insert 
Incident application from within your VantagePoint application. For 
more information see “Manually Forwarding Messages” on page  113.

Sending Annotations and Acknowledgments 

This integration is available for VantagePoint for Windows and for 
UNIX. Annotations can be sent to VantagePoint when an incident 
changes and an acknowledgement can be sent when the incident is 
closed. Agents on the VantagePoint server are sent commands based on 
database rules created in Service Desk.

“Sending Annotations to VantagePoint” on page  114, and “Sending 
Acknowledgments to VantagePoint” on page  116 for more information.

Viewing Service Desk CIs from VantagePoint

This feature is only available for VantagePoint for Windows. 
VantagePoint users can select a node in VantagePoint and launch a tool 
for opening the corresponding incidents for that configuration item in 
Service Desk. Service Desk and VantagePoint must be installed on the 
same machine. For more information see, See “Viewing Service Desk CIs 
from VantagePoint” on page 29 for configuration information and 
“Viewing Service Desk CIs from VantagePoint” on page  118 for 
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information on using the feature.

Viewing VantagePoint Service State From a Browser

This feature is available for VantagePoint for Windows and 
VantagePoint for UNIX. After installing and configuring one of the 
recommended Web Servers, VantagePoint service state can be viewed 
from a browser. See “Viewing VantagePoint Service State” on page  119.

Generating a VantagePoint Message From Service 
Desk

This feature is available for VantagePoint for Windows and UNIX 
servers. Smart Actions must be configured and the VantagePoint agent 
must be installed on the Service Desk client.

For more information see, See “Generate a VantagePoint Message from 
Service Desk” on page 65 and “Generating a VantagePoint Message 
From Service Desk” on page  122.

Monitoring Service Desk and Integration Processes

This feature is available both for VantagePoint for Windows and 
VantagePoint for UNIX servers. For Windows users, VantagePoint log 
file policies can be used to monitor Service Desk error log files and the 
Service Desk application server to ensure the integration is functioning 
properly. You can monitor errors in the Service Desk application server 
and the VantagePoint management server. The policies can be used to 
match specific log file lines, assign variables out of the intercepted lines 
and conduct pattern matching. 

VantagePoint for UNIX users can monitor the agent. See “Monitoring 
Service Desk Processes” on page  124 for details.

Suppressing Messages

This feature is available both for VantagePoint for UNIX servers. It 
makes it possible to suppress messages coming from the VantagePoint 
application for items that are undergoing scheduled outages defined in 
Service Desk.

See “Suppressing Messages in Service Desk” on page  123 for additional 
information.
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2 Installation 

This chapter explains the installation tasks for the Service Desk 
application server, VantagePoint for Windows and VantagePoint for 
UNIX servers.
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Requirements
Refer to the HP OpenView Service Desk: Installation Guide for detailed 
information on system requirements.

NOTE When using the VantagePoint for UNIX integration the correct version of 
Perl must be installed prior to installing the integration, and must be 
mentioned first in the path variables. Refer to the Installation Guide for 
information on the correct version of Perl to use. You can check what 
version of Perl is installed on your VantagePoint server with the 
command: perl -v

NOTE To create a WBEM ODBC source driver, WMI version 1085 core 
components are required. These components are available on the 
VantagePoint installation CD as wmicore_1085.exe in the directory 
/wmi.
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The VantagePoint Operation Integration includes a number of files and 
tools that need to be installed on the Service Desk and the VantagePoint 
servers. The following checklist shows the recommended order of 
installation:

1. VantagePoint application (refer to the VantagePoint documentation);

2. Web Server supplied with the VantagePoint application (refer to the 
VantagePoint documentation);

3. Service Desk server application;

4. Service Desk database;

5. Integrations with Data Exchange and hp OpenView Integration 
Option (service desk part) options selected;

6. VantagePoint agents on Service Desk server (refer to the 
VantagePoint documentation);

7. On your VantagePoint for Windows server:

• Integrations with the hp OpenView operation 
Integration(OVO server part) option selected.

• Service Desk agents on all VantagePoint for Windows machines.

• OvServiceExport.exe if you want to use the HTML Service Viewer.

8. On your VantagePoint for UNIX server install the HPOVSD depot 
file. You will need to copy it from the Service Desk CD-ROM.

TIP VantagePoint for Windows users can use either the Apache, or the 
Microsoft IIS Web server supplied with VantagePoint. VantagePoint for 
UNIX users should use the Apache Web Server. To check if Microsoft IIS 
is installed type the following in your browser: 
http://<server>/scripts/OvServiceExport.exe?-format+html.

To check for Apache: 
http://<server>:<portnumber>/cgi-bin/OVServiceExport.exe?-fo
rmat+html
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NOTE If Service Desk and VantagePoint are installed on the same application 
server you can install the integration for both at the same time. 

NOTE The VantagePoint Operation Integration for Windows does not work on 
multiple Service Desk application servers. You can only use it with one 
Service Desk application server, because of limitations in sd_event and 
in the distribution and function of the monitoring policies. 
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Installing on the Service Desk Server
To install the integration on Service Desk: 

1. Select the Integrations option from the Service Desk CD-ROM;

2. Select the Custom installation option.

3. Select hp OpenView operation Integration (service desk 
server part). 

4. Click Next to install:

Figure 2-1 Installation Features

5. The Installation program will install the integration.

If you are using VantagePoint for UNIX see“VantagePoint for UNIX 
Server” on page  40 for information on installing the rest of the 
integration on your UNIX server. If you are running VantagePoint for 
Windows on a different application server than Service Desk, see 
“VantagePoint for Windows Server” on page  37.

Installing Demo Data

Demo data can be installed and includes database rules, import 
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mappings, and smart actions used for this integration. You can save time 
by using the example rules and smart actions in the demo data rather 
than creating them manually for the integration. 

For information on creating a database and installing demo data, refer to 
the HP OpenView Service Desk: Installation Guide.

To create database rules see “Configuring Database Rules” on page  60 
for VPO for Windows or “Configuring Database Rules” on page  88 for 
UNIX. 
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VantagePoint for Windows Server
Files and tools need to be installed on the VantagePoint servers for the 
integration to work. This section explains the integration installation on 
a VantagePoint for Windows server. 

A table showing the key integration files and default locations for the 
VantagePoint for Windows server, can be found in Chapter 6, 
“Troubleshooting,” on page 125.

To install the integration on your VantagePoint Operation for Windows 
server:

1. Insert the Service Desk CD-ROM

2. Select the Integrations Option.

3. Select the Custom installation option.

4. Select the hp OpenView operations Integration (OVO part) 
check box only:

Figure 2-2 Feature Selection

5. Click Next to install.
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Installing the HTML Service Viewer

The HP VantagePoint Operation 6.0 HTML Service Viewer makes it 
possible for you to view services from a browser. VantagePoint for 
Windows uses a Web Server to perform this function. Refer to the HP 
OpenView Service Desk: Installation Guide for additional information 
about the Web Servers supported. To install the integration you will need 
to first copy OvService Export.exe.

For Apache users, OvServiceExport.exe needs to be put in a directory 
that Apache can run CGI scripts from (scripts directory).You can find 
this file in the folder OvServiceExport, which has been created by the 
integration installation program on the VPW server. The default 
directory is cgi-bin. Apache normally uses the System account when 
running executable files.

For MS-IIS 5.0 you need to put the OvServiceExport.exe file in a 
directory where the Web Server can start CGI scripts. The default 
directory is scripts. You need to modify the OvServiceExport.exe file 
with -cgi cgi root for this directory, for example: -cgi scripts. You 
will need to specify the user and accounts authorized to start the cgi 
scripts.

1. Start the Internet Services Manager. From the Start button, 
select Programs, Windows NT4.0 OptionPack, Microsoft 
Information Server, and then Internet Services Manager.

2. Open Default Web Site.

3. Click scripts. On the right portion of the screen you will see the 
content of the scripts directory.

4. Right-click scripts and then select Properties.

5. In the Virtual Directory tab verify that the Execute Permission 
parameter is set to Scripts and Executables and click OK.

6. Right-click OvServiceExport.exe on the right side of the window 
and then click Properties.

7. Open the File Security tab.

8. Click on Edit in the Anonymous access and authentication 
control rubric.

9. Enable Anonymous access and click Edit.

10.Specify a user that has the rights to access VantagePoint for Windows 
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services, for example: \Management Server\HP-OVE-User and the 
user’s password.

11. Close every window with OK.

NOTE For additional information review the readme.htm file that is included 
with the OvServiceExport tool.
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VantagePoint for UNIX Server
Files and tools need to be installed on the VantagePoint servers for the 
integration to work. This section explains the installation on a 
VantagePoint for UNIX server.

TIP To install the JAVA user interface on a Windows machine, copy using ftp 
/opt/OV/www/htdocs/ito_op/ITO_JAVA.exe from your VantagePoint 
for UNIX server to the c:\temp folder of your Windows client machine.

Run ITO_JAVA.exe to install the user interface.

Start ito_op.bat from the Start menu and fill in the user name, 
password (default is opc_op/OpC_op) and server name. For additional 
information refer to Chapter 3, in the VantagePoint Operation for 
HP-UX: Installation Guide.

A table listing key items that are installed on the VantagePoint for UNIX 
server with the default locations can be found at Chapter 6, 
“Troubleshooting,” on page 125.

Installing Files in the HPOVSD Depot

Install the hpovsd depot on your UNIX servers. The depot contains the 
VantagePoint Operation integration tools in a tar file called 
vantagepoint6_SD40.tar. The depot also contains the; ITO 5.3 
integration, SDevent, EventQueuing and the Service Desk Agent.

To install the integration:

1. Copy the hpovsd.depot to your tmp directory and then run: 

• # swinstall -s /tmp/hpovsd.depot
• # cd /opt/OV/SD/vantagepoint
• # tar xvof VantagePoint6_SD40.tar
• # ./install.sh

2. During the installation you will be asked a number of questions. The 
answers you give will be used to modify the sd_event.ini file located 
in; /opt/OV/SD/bin/sd_event.ini. The questions will be similar to 
the following:
  Chapter 240



Installation
VantagePoint for UNIX Server
• What is the version of your Oracle VantagePoint 
database? Please enter 7 or 8.

• What is the name of the Service Desk server? Enter the 
server you installed Service Desk on.

• What is the account to log in to Service Desk (log in 
name/password)? Enter the account you created for this 
Vantage Point server in Service Desk or use the default 
account from the demo data.

• What is the Oracle instance name of VantagePoint?Enter 
the alias name of the database VantagePoint uses.

• Do you want to upload the VantagePoint default 
configuration now? Enter Y to continue installation.

3. After answering the initial questions, a series of messages will appear 
and the installation program will start copying files to the default 
locations:

Starting installation of the VantagePoint integration...
Copying get_vp_attributes and sd_event files...

Copying file vp6.0/Dist-HP-UX-b.11.00_ORA-8.0.5_Release/get_vp_attributes to 
/opt/OV/bin/OpC/extern_intf
Copying file sd_eventins.sh to /opt/OV/bin/OpC/extern_intf
Copying file sd_event.sh to /opt/OV/bin/OpC/extern_intf
Copying file sd_eventins.pl to /opt/OV/bin/OpC/extern_intf
Copying file sd_event.ini to /opt/OV/bin

Uploading configuration...
perl is <location where you installed perl>

4. During installation a log file called; install.log, will be created in 
the log folder. When the installation is successful, you will see the 
message:

Installation of the VantagePoint integration has been completed without 
errors.

Installing the HTML Service Viewer

The HP VantagePoint Operation HTML Service Viewer is an additional 
VantagePoint feature packaged with this integration. The Service Viewer 
makes it possible to view services on the VantagePoint server from a 
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browser. To install the Service Viewer:

1. Untar the file: 
/opt/OV/SD/vantagepoint/service_view/vpo_service_view_cgi
.tar

2. Run the install script: #/opt/OV/www/cron/install.sh

3. In your browser, type the following URL: http://<server 
name:8880/vpo_top_services.html

The web page will be updated by the server once every minute. If you see 
only an input field for a service ID then there are no services registered 
in the VantagePoint Operation service status engine.

NOTE Cron jobs will also appear in the VantagePoint for UNIX message 
browser. You can keep the cron jobs from appearing by suppressing them 
in the message source templates.

TIP You can add the following sample services for demonstration purposes:
opcservice -add /opt/OV/OpC/examples/services/banking.xml
opcservice -add /opt/OV/OpC/examples/services/sap.xml
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Multiple VantagePoint Servers
To support multiple VantagePoint servers you will need to:

• Install the VantagePoint Operation Integration on each server.

• Create a separate account in Service Desk for each VantagePoint 
server and specify the host name for each account. The host name is 
used when sending acknowledgments and annotations to the 
VantagePoint server. For example:

Account Host

VPW_account1 server1.yourdomain.com

VPW_account2 server2.yourdomain.com
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3 VPO for Windows and Service 
Desk Configuration

Configuration tasks need to be performed on the Service Desk server and 
the VantagePoint server. Some default settings and values are provided. 
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This section explains the configuration steps that must be done in 
Service Desk. The tasks are listed below:

• Create a VantagePoint Integration account

• Set the environment variable for Service Desk.

• Import managed nodes as configuration items.

• Import services as configuration items.

• Modify the import mapping for events (forwarded messages).

• Create database rules.

• Create Smart Actions.

The following configuration tasks need to be done in the VantagePoint 
for Windows application:

• Set the environment variable, OV_PATH.

• Modify the sd_event.ini file.

• Modify the forwarding policy (not mandatory).

• Deploy the forwarding policy.

• Deploy monitoring policies.

• Deploy opcmsg. 

• Configure VantagePoint tool for viewing configuration items.

Creating a VantagePoint Server Account

Every VantagePoint server that will be integrated with Service Desk 
needs to have a Service Desk account. UNIX servers need to have an 
account starting with VPU, and Windows servers need to have an 
account starting with VPW. The account and host name of the 
VantagePoint server is used by the database rules to register and send 
acknowledgments and annotations to the VantagePoint servers. Default 
accounts will be created when you install your database.

Keep the following in mind when creating accounts for each 
VantagePoint server you will integrate with Service Desk:
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• Accounts must start with VPW or VPU, followed with the server host 
name, for example VPW_VantagePointserver1.

• Create non-user interface accounts for integrations.

• Access rights need to include the Helpdesk role as a minimum.

For specific information on creating accounts in Service Desk refer to the 
Administrator’s Guide or the Online Help.

Setting the Environment Variable for Service Desk

The environment variable needs to be set on Service Desk application 
server so that VantagePoint can find the log file for the Service Desk 
server for monitoring purposes. The variable can be set from the System 
Properties dialog box:

1. Go to the location where you set environment variables. This differs 
by operating system, for Windows 2000 users, go to the Start menu, 
select Settings, then Control Panel, then System and click the 
Environment Variables button.

2. Select SD_PATH in the System Variables portion of the window. If 
the SD_PATH variable is not present you can create it as shown in 
the following dialog box. The value field must contain the complete 
path to the folder where logserver.txt is located:
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Figure 3-1 System Properties - SD_PATH

3. Click OK when finished.

Putting the Service Desk Bin folder in the Path

If you want to be able to open a Service Desk form while working in 
VantagePoint you will need to include the Bin folder in the Service Desk 
path.

A folder called <SD product path>\Client\Bin on a Service Desk client 
installation, or <SD product path>\Server\Bin on a Service Desk 
server, contains the file SDDataForm.exe. This file is triggered by 
VantagePoint to send a request via the command line to open a specified 
Service Desk data form. This will only work when VantagePoint and 
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Service desk are installed on the same computer. For VantagePoint to 
find SDDataForm.exe the path must be included in the Windows 
Environment variables. You can add the bin folder to the path by 
performing the following steps:

1. Go to the location where you set environment variables. This differs 
per operating system.

2. Select Path from the list of system variables.

3. Change the value of the path by adding <SD product 
path>\Client\Bin or <SD product path>\Server\Bin to the 
end of the path, which one you add depends on whether you are 
running VantagePoint on the same machine as the Service Desk 
server or a client. Use a semi-colon as a separator.

4. Click Set when finished, then OK to save it.

5. Verify that it works by using the DOS command: 
SDDataForm Incident Configurationitem.Searchcode=XXXXX

Where XXXXX is the search code of a configuration item in your Service 
Desk database.

NOTE To start Service Desk in context with SDDataForm.exe, the Service Desk 
Client or Server must be installed on the same machine as VantagePoint.

Importing Nodes Into Service Desk

In Service Desk configuration items need to exist for all nodes managed 
by VantagePoint. This step needs to be performed so that events coming 
from the VantagePoint server can find the configuration item they are 
related to in Service Desk. The VantagePoint server is also a managed 
node. 

NOTE Changing any item in Service Desk, for example adding or changing the 
name of a status used for CIs, effects the import mapping used for 
importing nodes. For the import mapping to work completely you will 
either need to modify the template used for the import mapping and fill 
in the right status with the new values for example, or you can modify 
Chapter 3  49



VPO for Windows and Service Desk Configuration
Overview
your Service Desk application to match the import mapping.

Import Mapping for Importing Nodes

The import mapping for importing nodes as configuration items is shown 
with default values in the following figure:

Figure 3-2 Import Mapping CI Nodes - Windows

For additional information on modifying the import mapping, refer to the 
Chapter entitled “Import Mapping” in the HP OpenView Service Desk: 
Data Exchange Administrator’s Guide.

Configurable Extractor for VPO for Windows Nodes

A configurable extractor is used to define how the nodes should be 
exported from the VantagePoint database. An example of the extractor 
file, vpwindowsci.ini, with default settings follows:

vpwindowsci.ini file for Vantage Point for Windows and 
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Service Desk integration.
; Used for VPW managed node -> SD CI data exchange.

[DSN]
NAME=             WBEM Source
USR=
PWD=
DBQ=              root\HewlettPackard\OpenView\VantagePoint
SERVER=
SYSPROPS=         TRUE
NAMESPACES=       
{root\HewlettPackard\OpenView\VantagePoint,deep}
UIDPWDDEFINED=    TRUE

[SYSTEM]
LOG=              TRUE
XML=              TRUE
LOG_FILE=         C:\temp\VPW.log
OUTPUT_FILE=      c:\temp\VPW.txt
XML_OUTPUT_FILE=  c:\temp\VPW.xml
APPLICATION_NAME= VPW

[CLASSES]
NAME=             MANAGED_NODE

[MANAGED_NODE]
SOURCE=           OV_ManagedNode
ATT=              PrimaryNodeName, Caption, __RELPATH
COLUMNS=          OV_ManagedNode.PrimaryNodeName, 
OV_ManagedNode.Caption, OV_ManagedNode.__RELPATH
LOADTABLE=        TRUE

Importing Nodes From VantagePoint for Windows

A Data Exchange Task is configured in the demo database for performing 
this action. Nodes can be imported from the Service Desk application 
server as follows:

1. Create an ODBC link. From the Windows control panel, click ODBC 
Data Sources. Open the System DSN tab and select the WBEM 
Source:
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NOTE The WBEM ODBC driver must be installed on Windows prior to starting 
this installation. It is available on the CD-ROM or can be obtained 
from Microsoft.

Figure 3-3 ODBC Data Source Administrator dialog box

Figure 3-4 Setup WBEM ODBC Datasource
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2. Use the Data Exchange task vpwindowsci (for Windows servers) to 
import all managed nodes as configuration items. 

Figure 3-5 Importing Managed Nodes - Windows

3. Check the log files vpwindows_exp.log and 
vpwindowsci_imp_error.log for errors.

For additional information about how to use Data Exchange for 
exporting and importing data, please refer to the HP OpenView Service 
Desk: Data Exchange Administrator’s Guide.

Multiple VantagePoint Servers

If the VantagePoint for Windows server and the Service Desk application 
server are not located on the same machine, choose one of the two 
following options:

Option 1:
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1. On the Service Desk application server, install the Microsoft WMI 
SDK from: http://msdn.microsoft.com/downloads/sdks/wmi/ 
This contains the WBEM ODBC driver.

2. Modify the files vpwindowsci.ini and vpwindowsservices.ini. 
Under the DSN section, locate the Server=keyword. Specify the 
VantagePoint server as the value, for example \\MYVPSERVER.

3. Export and import the data on the Service Desk application server.

Option 2:

1. Install the Service Desk client, including data exchange and the files 
vpwindowsci.ini and vpwindowsservices.ini on the VantagePoint 
server.

2. Export the data on the VantagePoint server.

3. Move the resulting XML file to the Service Desk application server.

4. Import the data on the Service Desk application server.

Manually Creating a Configuration Item 

You can manually create Configuration Items in Service Desk for all or 
part of your managed nodes. To create a configuration item for a 
managed node:

1. Open a new Configuration Item dialog box. This can be done by 
selecting Configuration Item from the shortcut bar or selecting New 
then Configuration Item from the File menu.

2. In the search code field, enter the name of the managed node. 

3. In the Name 1 field, enter the complete host name for the managed 
node:
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Figure 3-6 Configuration Item dialog box

Importing Services Into Service Desk

In Service Desk, configuration items can be made for VantagePoint 
services. A Data Exchange Task is provide with the integration for 
performing this action. Services can be imported from the Service Desk 
application server as follows:

1. Create an ODBC link. From the Windows control panel, click ODBC 
Data Sources. Open the System DSN tab and select the WBEM 
Source.

2. Update the DSN section of the vpwindowsservices.ini file.

3. Verify that the Operational Level Service category is included in 
the VPService template. See “Creating the Operational Level Service 
Category” on page  56 for details.

4. Use the Data Exchange task vpwindowsservices (for Windows 
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servers) to import all managed nodes as configuration items. 

5. Check the log files vpwindows_exp.log and 
vpwindowsci_imp_error.log for errors.

NOTE Limitations exist when mapping fields in VantagePoint for Windows to a 
Service Desk Search code. The WMI ODBC driver requires search codes 
to be written in uppercase letters without spaces. A default attribute 
value called VPWIndowsCI is present in the import mapping as a solution 
to this limitation. If you are importing services from VantagePoint to 
Service Desk the caption field in the VPW may contain spaces and/or 
wildcard characters which are not allowed in the search code field of 
Service Desk and will result in errors in the import log file. As a result, 
when an external VantagePoint for Windows attribute is imported that 
contains spaces or is not in uppercase, the default value will be given. 
Attributes in the wrong format will be given the default value while 
others meeting the ODBC driver’s criteria will be imported with their 
true values. This only applies to the VantagePoint for Windows 
integration and not the UNIX integration because different ODBC 
drivers are used.

Creating the Operational Level Service Category

The Operational Level Service category may already be included in 
the VPService template in your database. The category is used when you 
import VantagePoint services as Service Desk configuration items. 

To create the category and add it to the template if it is not present:

1. From the Tools menu select System, then click Data, then Codes, and 
Configuration Item from within the Administrator Console.

2. Click CI Category, then right-click in the screen and select New CI 
Category from the menu that appears.

3. In the New CI Category dialog box enter Operational Level 
Service, in the Text field and leave the Parent field empty:
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Figure 3-7 New CI Category

4. Verify that there is no checkmark in the Blocked check box, and click 
OK:

Figure 3-8 CI Category Operational Level Service

5. Next, you will need to add the new category to your VPSERVICE 
template. From the Data folder select Templates, then 
Configuration Item. Open the VPSERVICE template:
Chapter 3  57



VPO for Windows and Service Desk Configuration
Overview
Figure 3-9 VPSERVICE - Template

6. Double-click the Category entry and use the Quick Find feature to 
locate the Operational Level Service category you created.

7.  Select the Operational Level Service category and click OK to add 
it to the template.

Modifying the Import Mapping for Events

An import mapping with default values, called vpwindows, is provided 
for the VantagePoint Operation integration, you can modify the import 
mapping as needed.

VantagePoint message attributes are mapped to Service Desk incident 
attributes. 

For detailed information on modifying or creating a new import 
mapping, refer to theHP OpenView Service Desk: Data Exchange 
Administrator’s Guide. 

The default import mapping can is shown in the following dialog box:
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Figure 3-10 VP Windows Mapping

Mapping Event Information for Windows

You can send event information from VantagePoint to Service Desk using 
the WMI policy that intercepts OV_Messages and uses a Visual Basic 
script called Vpw-Sd.vbs to call sd_event and forward some of the 
attributes to Service Desk, creating a corresponding incident in Service 
Desk. The policy must be deployed on the VantagePoint management 
server machine. The attributes are mapped as follows:

Table 3-1 Default Attribute Mapping - Windows

Properties
Message Attributes

Fields

Id Event_id

Test (first 80 char) Description

Original message Information
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Configuring Database Rules

Database rules can be used to send information from Service Desk to 
VantagePoint. A Service Desk agent must be running on each 
VantagePoint server to execute the commands specified in the rules. The 
following sections contain example for setting up rules to send 
annotations and acknowledgments.

NOTE Clear the Blocked check boxes for the action and for the rule to activate 
them.

Send Acknowledgment to VantagePoint for Windows

You can configure a database rule to send acknowledgments to 
VantagePoint for Windows as follows:

Original text Information

Application Information

Object Information

Annotation 1 - Annotation n 
(concatenated)

Information

OV_Message.GetInstruction() Solution

OV_ManagedNode.PrimaryNodeN
ame

CI

Severity Impact (mapped)

Table 3-1 Default Attribute Mapping - Windows

Properties
Message Attributes

Fields
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Figure 3-11 Database Rule to Send Acknowledgment to VPO for Windows

• For each modified incident;

• if [Registration; Create by; Login name]starts with VPW;

• and status is changed to closed;
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Figure 3-12 Action to Send Acknowledgment to VPO for Windows 

• on Host: [Registration;Created by;Host]

• execute the command: cscript

• with the parameters: 
/NoLogo "\"%OV_PATH%\\bin\\tools\\Vpw-Sd.vbs\"" [Source 
ID] OV_MessageUpdate_Acknowledge

NOTE To create the environment variable OV_PATH, refer to “Setting the 
Environment Variable for VantagePoint” on page  68.

Send Annotations to VantagePoint for Windows

You can configure a database rule to send annotations to VantagePoint 
for Windows as follows:
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Figure 3-13 Database Rule to Send Annotations to VPO for Windows

• for each inserted incident;

• if [Registration; Created by;Loginname] starts with VPW;
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Figure 3-14 Action for Sending Annotations to VPO for Windows

• execute on host: [Registration; Created by;Host]. 

• the command: cscript

• with parameters:
/NoLogo "\"%OV_PATH%\\bin\\tools\\Vpw-Sd.vbs\"" [Source 
ID] OV_MessageUpdate_AddAnnotation "\"A Service Desk 
incident has been created with number [ID]\""

TIP Create new database rules quickly by using the copy and paste functions. 
Select a rule that is similar to the rule you want to create and click 
CTRL+C then CTRL+V to make a copy. Double-click the copied rule to open 
it and then use the database rules Wizard to change the parameters and 
the name.
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View VantagePoint State from Service Desk

You can view current VantagePoint Service State from a browser in 
Service Desk. See “Installing the HTML Service Viewer” on page 38, and 
“Viewing VantagePoint Service State” on page  119 for more information.

See “View The Current Status of a VantagePoint Service From Service 
Desk” on page  92, for an example of how the smart actions have been set 
up for VantagePoint on Unix.

NOTE If you are using smart actions to view service statuses, your 
VantagePoint Web site needs to be entered in the parameters portion of 
the smart action. Normally the Web site will be the same as your 
VantagePoint server.

TIP A number of functions available with this integration use the Smart 
Actions feature in Service Desk. To create a new Smart Action:

1. From the Tools menu, select System, then click Business Logic, 
Actions, then Smart Actions.

2. Click the item that you want to create a smart action for. For 
example; a configuration item or a Service Call.

3. Right-click and select New Smart Action from the popup menu.

Additional information on setting up and using Smart Actions can be 
found in the Online Help for Service Desk. 

Generate a VantagePoint Message from Service Desk

The Generate VP message manually Smart Action can be used to 
forward an Incident to the VantagePoint operator. If configured correctly 
this manually generated message will not cause the automatic 
trouble-ticket interface in VantagePoint to generate a new incident in 
Service Desk. 

First make sure the VantagePoint Agent is installed on the VantagePoint 
Management Server. The default location is: 
C:\WINNT\Hewlett-Packard\OVEnterprise\Agent\unique_code\bin
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The opcmsg application can be found in the same folder. The system 
environment variable PATH contains the exact path to this program, so 
that it can be called without specifying the folder location. The opcmsg 
application can be used to forward field information from a Service Desk 
incident to the VantagePoint Management Server. 

To set up the opcmsg application:

1. Open the Administrator Console in Service Desk, then click Business 
Logic, and then open Applications.

2.  Right-click and select New Application from the menu. Define the 
application as shown in the following dialog box:

Figure 3-15 Opcmsg Application

3. Next, create a Smart Action using the opcmsg application as follows:
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Figure 3-16 Generate VP Message Manually

The parameters entered determine what information from the Incident 
will be passed to the VantagePoint application. The parameters use the 
VantagePoint application’s opcmsg syntax. In the example above a 
equals Application, and o equals Object. 

Your system administrator will need to provide access to this smart 
action for all clients that will be using it. The opcmsg command will also 
need to be deployed to the host machines of the Service Desk clients that 
will use the command. Only then will it be possible to execute opcmsg to 
log an event in the VantagePoint Management Server’s Active messages 
window from remote client machines.

For more information on deploying opcmsg, see “Deploying Opcmsg to 
Service Desk Clients” on page  71.

To stop VantagePoint from forwarding the message to Service Desk, 
creating a duplicate incident, the Forward Message to Service Desk 
policy should be configured so that it does not forward messages to 
Service Desk that originated from Service Desk. The messages will 
remain in the VantagePoint browser.

VantagePoint for Unix users can use the ForwardTroubleTicket:flag to 
stop the forwarding of events that originated from Service Desk. This 
option can be turned on or off in the template by the VantagePoint 
operator. In VantagePoint for Windows this option cannot be changed in 
a message, but the option is present for providing compatibility with 
VantagePoint for UNIX. 
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VantagePoint for Windows
This section explains the configuration tasks to be done in the Vantage 
Point application. For an overview of all configuration tasks, see 
“Overview” on page  46.

Setting the Environment Variable for VantagePoint

The environment variable needs to be set on your VantagePoint for 
Windows application server. To set the variable:

1. Go to the location where you set the environment variables for your 
Windows operating system.

2. Select OV_PATH in the System Variables portion of the window. If the 
OV_PATH variable is not present you can create it as shown in the 
following dialog box:
  Chapter 368



VPO for Windows and Service Desk Configuration
VantagePoint for Windows
Figure 3-17 System Properties - OV_PATH

3. Click OK when finished.

Modifying the Configurable Extractor File

Modify the configurable extractor, sd_event.ini. The default location is: 
C:\Program Files\Hewlett-Packard\OVEnterprise\bin\tools . 
Many of the items will be configured automatically for you during the 
installation process. You will want to update the ACCOUNT and SERVER 
entries, as a minimum. If you changed the name of the import mapping 
supplied with this integration, you will need to enter the new name in 
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the MAPPING row. A copy of the example sd_event.ini file follows:

[SD_Event]
LOGFILE=sd_event.log
ERROR_LOGFILE=sd_event_error.log
ACCOUNT=VPW_server1/Password
SERVER=your server
PORT=30980
MAPPING=vpwindows
CLASSNAME=incident
MODUS=insert

Modifying the Forwarding Policy

The policies called Forward message to Service Desk and Forward 
message changes to Service Desk are configured to forward all major 
and critical messages that are not log only. You can specify what 
messages are forwarded by editing the conditions of the policy. To edit 
the policy:

1. Right-click on the Forward message to Service Desk policy and select 
All Tasks, then Edit.

2. In the Rules tab, click Modify. 

3. Click Add or Modify to change the conditions for each rule.

For additional information refer to the Online Help in your VantagePoint 
for Windows application.

Deploying the Forwarding Policies

The policies called Forward messages to Service Desk and Forward 
message changes to Service Desk need to be deployed on your 
application server every time you make a change. To deploy the policy:

1. Right-click on the policy and select All Tasks, then Deploy On.

2. Select your management server node you want to deploy it on.

3. Click OK.

For additional information refer to the Online Help in your VantagePoint 
for Windows application.
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Deploying the Monitoring Policies

Policies are supplied to monitor this integration. After installing the 
integration you need to deploy the policies to the proper locations. The 
list below shows the policies and where they need to be deployed:

Deploying Opcmsg to Service Desk Clients

Opcmsg is used to create VantagePoint messages from Service Desk. You 
need to deploy this policy to all Service Desk clients that you want to be 
able to perform this function from. To deploy the policy:

1. In the VantagePoint management console, open Policies grouped 
by type.

2. Open the Open Message Interface policy group.

3. Select the opcmsg policy, right-click and then select All Tasks, then 
Deploy on. 

4. Select all of the Service Desk client nodes that you want to be able to 
manually create VantagePoint messages from and click OK.

For additional information refer to the Online Help in your VantagePoint 
for Windows application.

Configuring VantagePoint Tools

A VantagePoint tool is supplied with this integration for viewing Service 
Desk configuration items when you have the related node selected in 
VantagePoint. After installing the integration, you need to configure the 
target nodes for the tool. Tools can be:

• run on the nodes you specify;

• configured to permit users to choose the nodes on which the tool will 
run;

• run in the context of a service (run on the node that hosts that 
service).

Use the Target tab in the Tool Properties dialog box to select the nodes 

Monitor sd_event logfile VantagePoint management server

Monitor Service Desk logfile Service Desk server
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on which you want the tools to run. You must also specify Node List in 
the Execute On list. This configures the tool to run on all the nodes in 
the Predefined Node List. 

If you prefer to allow your users to determine where a tool is to be run, 
you must choose Selected Node in the Execute On list. When the tool is 
executed, a list appears from which users choose the location (service or 
node) where the tool will run.

For additional information on using VantagePoint Tools, refer to the 
Online Help in the VantagePoint for Windows application.

Viewing Service Desk CIs from VantagePoint

This section shows how to configure a VantagePoint for Windows tool to 
open a Service Desk configuration while working in VantagePoint. 

In your VantagePoint for Windows application:

1. Open the Tool Properties dialog box and enter a name for the tool in 
the General tabbed page:

Figure 3-18 Show Configuration Item - General tab

2. Open the Details tabbed page and enter Executable in the Command 
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Type field:

Figure 3-19 Show Configuration Item - Details tab

3. In the Command field enter SDDataform.exe. This is the Service Desk 
program capable of opening a dialog box. You will need to have put 
the Bin folder in the path for the VantagePoint to find 
SDDataform.exe, see “Putting the Service Desk Bin folder in the 
Path” on page  48.

4. In the Parameters field enter "Configuration Item" 
Searchcode=$OPC_NODES.

If you used the default import mapping to import node information, 
PrimaryNodeName data is imported into the Configuration Item field 
Searchcode. It is recommended that you use unique search codes to 
prevent errors.

5. In the Target tabbed page enter Console in the Execute On: field. 
This will allow the program to interact with your console:
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Figure 3-20 Show Configuration Item - Target tab
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4  VP UNIX and Service Desk 
Configuration

The configuration tasks that need to be performed in Service Desk and 
on the VantagePoint for UNIX server are explained in this chapter.
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The following configuration steps need to be performed on your Service 
Desk and your VantagePoint for Unix application servers.

On the Service Desk application server:

• Create a VantagePoint Integration account.

• Set the environment variable for Service Desk.

• Import managed nodes as configuration items.

• Import services as configuration items.

• Modify the import mapping for events (forwarded messages).

• Configure database rules.

• Configure Smart Actions.

• Configure outage planning to suppress messages (optional).

On your VantagePoint Server running on UNIX:

• Modify the sd_event.ini file.

• Configure mkoutage.conf and templates for outage planning 
(optional).

• Make Service Desk a VantagePoint user.

• Move the Service Desk application to Application Bank.

• Modify the message source templates.

• Deploy the monitoring policies

• Configure the Service Desk agent.

Creating a VantagePoint Server Account

Every VantagePoint server that will be integrated with Service Desk 
needs to have a Service Desk account. UNIX servers need to have an 
account starting with VPU. The account and host name of the 
VantagePoint server are used by database rules to register and send 
acknowledgments and annotations to the VantagePoint servers.

For specific information on creating accounts in Service Desk refer to the 
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Administrator’s Guide or the Online Help.

Setting the Environment Variable for Service Desk

The environment variable needs to be set on Service Desk application 
server so that VantagePoint can find the log file for the Service Desk 
server for monitoring purposes. If the SD_PATH variable is not present 
you will need to enter the value field with the complete path to the folder 
where logserver.txt is located. See “Setting the Environment Variable for 
Service Desk” on page  47 for an example.

Importing Nodes Into Service Desk

In Service Desk configuration items need to be made for all nodes 
managed by VantagePoint. This step needs to be performed so that 
events coming from the VantagePoint server can find the configuration 
item they are related to in Service Desk. The VantagePoint server is also 
a managed node. 

NOTE Changing any item in Service Desk, for example adding or changing the 
name of a status used for CIs, effects the import mapping used for 
importing nodes. For the import mapping to work completely you will 
either need to modify the template used for the import mapping and fill 
in the right status with the new values for example, or you can modify 
your Service Desk application to match the import mapping.

Import Mapping for Importing Nodes

The import mapping for importing nodes as configuration items is shown 
with default values in the following figure:
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Figure 4-1 Import Mapping CI Nodes - Unix

For additional information on modifying the import mapping, refer to the 
Chapter entitled “Import Mapping” in the HP OpenView Service Desk: 
Data Exchange Administrator’s Guide.

Configurable Extractor for VP Unix Nodes

A configurable extractor is used to define how the nodes should be 
exported from the VantagePoint database. An example of the extractor 
file with default settings is provided with this integration, vpunixci.ini,for 
UNIX:[DSN]

NAME=VP for Unix

USR=opc_op

PWD=opc_op

[SYSTEM]

LOG=TRUE
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XML=TRUE

LOG_FILE=vpunixci.log

OUTPUT_FILE=vpunixci.txt

XML_OUTPUT_FILE=vpunixci.xml

APPLICATION_NAME=vpunixci

[CLASSES]

NAME=nodes

-- create a searchcode from the node name by taking the first 
part

-- to the period, make it upper case and remove hyphens

[nodes]

SOURCE=OPC_NODE_NAMES

ATT=[searchcode],[node_name],[ip_address]

COLUMNS=replace(upper(substr([node_name],1, 
instr([node_name],’.’)-1)), ’-’,’’) as [searchcode], 
[node_name],trunc((ip_address/(256*256*256))) || ’.’ || 
trunc(mod(([ip_address]/(256*256)),256)) || ’.’ || 
trunc(mod(([ip_address]/256),256))  || ’.’ || 
mod([ip_address],256) as [ip_address]

-- (([ip_address]/(256*256*256)) Mod 256) & "." & 
((([ip_address]/(256*256)) Mod 256)) & "." & 
((([ip_address]/256) Mod 256)) & "." & ([ip_address] Mod 
256) as [ip_address]

condition=[node_name] is not null

LOADTABLE=TRUE

Importing Nodes From VantagePoint for UNIX

A Data Exchange Task is configured in the demo database for performing 
this action. The Oracle database must be accessible from the Service 
Desk application server for this action to work. Nodes can be imported 
from the Service Desk application server as follows:

1. Create an ODBC link to the VantagePoint server. The ODBC link VP 
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for Unix is automatically created during installation. From the 
Windows control panel, click ODBC Data Sources. Select the System 
DSN tab. In the Server field enter the Oracle connect string for the 
VantagePoint for UNIX database. The Oracle instance name is 
openview by default. The following figure shows and example ODBC 
link for a VantagePoint for UNIX Oracle database as an example:

Figure 4-2 ODBC Link for VP UNIX Oracle database 

2. After the link is established, use the Data Exchange task vpunixci 
(for UNIX servers) to import all managed nodes as configuration 
items. The default user name and password is opc_op, it can be 
changed if needed. The open task will resemble the following:
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Figure 4-3 Data Exchange Task for Importing Nodes for UNIX

3. Check the log files vpunix_exp.log and vpunixci_imp_error.log 
for errors.

For additional information about how to use Data Exchange for export 
and importing data, please refer to the HP OpenView Service Desk: Data 
Exchange Administrator’s Guide.

Manually Creating a Configuration Item 

You can manually create Configuration Items in Service Desk for all or 
part of your managed nodes. This may be easier when adding one or two 
nodes rather than running the Data Exchange process again.

To create a configuration item for a managed node:

1. Open a new Configuration Item dialog box. This can be done by 
selecting Configuration Item from the shortcut bar or selecting New 
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then Configuration Item from the File menu.

2. In the search code field, enter the name of the managed node. 

3. In the Name 1 field, enter the complete host name for the managed 
node:

Figure 4-4 Configuration Item dialog box

Importing VantagePoint for UNIX Services

To export Services from VantagePoint for UNIX and import them as 
configuration items in Service Desk, you will need to save the data in 
ASCII text format and use an ODBC text editor as explained in the 
following steps:

1. An ODBC text link to the vp_services.txt file is created when you 
install this integration. If you need to, you can create it manually as 
follows:
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a. Select the System DSN tab and click Add.

b. Select Microsoft Text Driver and then click Finish.

c. Enter vp_services in the Data Source Name field.

d. Enter vp_services in the Description field.

e. Click Select Directory and enter Service Desk product 
path\data_exchange\xml. Clear the Use Current Directory 
check box:

Figure 4-5 ODBC Text Link

2. A file was created called schema.ini in: product path\data_ 
exchange\xml. If the creation of the file did not occur, you can create 
the file manually. This file is used to define the structure of the 
vp_services.txt file. An example of this file follows:

[vp services.txt]
ColNameHeader=False
Format=CSVDelimited
MaxScanRows=1
CharacterSet=OEM
Col1=ITEM Char Width 255
Col2=COLUMN1 Char Width 255
Col3=COLUMN1 Char Width 255
Col4=COLUMN1 Char Width 255
Col5=COLUMN1 Char Width 255

3. Another configuration file called vpunixservices.ini is installed 
automatically during installation. Verify that the file is located in the 
Service Desk product path\data_exchange\config folder. You 
may need to change the default settings in the DSN section. An 
example of the file follows:
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[DSN]

NAME=vp_services

USR=

PWD=

[SYSTEM]

LOG=TRUE

XML=TRUE

LOG_FILE=vpunixservices.log

OUTPUT_FILE=vpunixservices.txt

XML_OUTPUT_FILE=vpunixservices.xml

APPLICATION_NAME=vpunixservices

[CLASSES]

NAME=SERVICES,DEPENDENCIES

-- For services :

-- column1 = searchcode

-- column2 = name

-- column3 = label

-- column4 = title

[SERVICES]

SOURCE=vp_services.txt

ATT=[COLUMN1],[COLUMN2],[COLUMN3],[COLUMN4]

COLUMNS=[COLUMN1],[COLUMN2],[COLUMN3],[COLUMN4]

CONDITION=[ITEM]=’SERVICE’

LOADTABLE=TRUE

-- For dependencies :

-- column1 = source

-- column2 = target

-- column3 = type (DEPENDENCY or COMPOSITION)

[DEPENDENCIES]

SOURCE=vp_services.txt
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ATT=[COLUMN1],[COLUMN2],[COLUMN3]

COLUMNS=[COLUMN1],[COLUMN2],[COLUMN3]

CONDITION=[ITEM]=’RELATION’

LOADTABLE=TRUE

4. Verify that the Operational Level Service category is included in 
the VPService template in Service Desk. See “Creating the 
Operational Level Service Category” on page  56 for details on how to 
create it if it is not present.

5. On the VantagePoint for UNIX server, in /opt/OV/SD/vantagepoint, 
run ./vp_services to generate a complete list of services and to 
transform the service information into a comma separated file called 
vp_services.txt that can be read by Data Exchange

6. Transfer the generated file to Service Desk product 
path\data_exchange\xml on your Service Desk application server 
with the ftp command.

7. Open and run the import task in Data Exchange called: 
vpunixservices. An example of the open task follows:
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Figure 4-6 Import Services Task for UNIX

8. At the bottom of the Data Exchange dialog box, click List Log 
Files. Open vpunixservices_imp_error.log when it appears in 
the file window and check if any errors are written into the file.

NOTE An example text file called vp_services_sample.txt is delivered with 
this integration. You can rename it to vp_services.txt and use it for 
demonstration purposes.

NOTE To view another example of importing data from an ASCII text file, see 
Appendix A, “Examples” in the HP OpenView Service Desk: Data 
Exchange Administrator’s Guide.
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Modifying the Import Mapping for Events

An import mapping file with default values is provided for the 
VantagePoint Operation integration, you can modify the import mapping 
as needed. For additional information on import mapping, refer to the 
HP OpenView Service Desk: Data Exchange Administrator’s Guide.

The default import mapping supplied with this integration follows for 
VantagePoint on UNIX. 

Figure 4-7 Import Mapping for VantagePoint on UNIX

The interface for forwarding messages to Service Desk uses the 
VantagePoint API to get message details. This provides access to 48 
message attributes in VantagePoint, for example (on UNIX), message ID, 
message text, instructions, and annotations. You can configure the 
sd_eventins.pl file to insert VantagePoint message attributes into the 
Remark and Information fields of an incident in Service Desk. For 
Example: information=\”Application: 
$VantagePoint_params{APPLICATION}; Object: 
$VantagePoint_params{OBJECT}\”.
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For detailed information on modifying or creating a new import 
mapping, refer to theHP OpenView Service Desk: Data Exchange 
Administrator’s Guide. 

Configuring Database Rules

Database rules can be used to send information from Service Desk to 
VantagePoint. A Service Desk agent must be running on each 
VantagePoint server to execute the commands specified in the rules. The 
following sections contain examples for setting up rules to send 
annotations and acknowledgments, and for starting the outage tool 
mkoutage in VantagePoint.

Send Acknowledgment to VantagePoint for UNIX

To send acknowledgment messages to VantagePoint for Unix, the 
database rule can be configured as follows:

Figure 4-8 Database Rule to Send Acknowledgments to VPO for UNIX

• for each modified incident;

• if [Registration; Created by;Loginname]starts with VPU;

• and status is changed to closed;
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Figure 4-9 Action to Send Acknowledgments to VPO for UNIX

• on host: [Registration;Created by;Host]

• then execute the command: /opt/OV/bin/OpC/opcackmsg

• with the parameter: [Source Id]

Send Annotations to VantagePoint for UNIX

To send annotations to VantagePoint for UNIX, the database rule can be 
configured as follows:
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Figure 4-10 Database Rule to Send Annotations to VPO for UNIX

• for each inserted incident;

• if [Registration; Created by;Loginname] starts with VPU;
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Figure 4-11 Action to Send Annotations to VPO for Unix

• execute on host [Registration; Created by;Host]

• the command: opt/OV/bin/OpC/opcannoadd

• with parameters:[Source ID] "A Service Desk incident has 
been created with number [ID]."

NOTE opcackmsg and opcannoadd are not part of the VantagePoint Operation 
Integration software, they are part of the VantagePoint application and 
are located in /opt/OV/bin/OpC.

Creating New Database Rules

Additional information about creating database rules can be found in the 
HP OpenView Service Desk: Administrator’s Guide.
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TIP Create new database rules quickly by using the copy and paste functions. 
Select a rule that is similar to the rule you want to create and click 
CTRL+C then CTRL+V to make a copy. Double-click the copied rule to open 
it and then use the Wizard to change the parameters and the name.

View The Current Status of a VantagePoint Service 
From Service Desk

These smart actions make it possible for helpdesk employees or 
specialists to view the current state of a VantagePoint service in a Web 
browser. In the examples, the service is identified by the name1 field of 
the configuration item. When configuring this Smart Action, ensure that 
you enter the correct VantagePoint server name.

Item Configuration Item

Name Show VP for Unix service State

Application Internet Explorer

Parameters http:/VPU_server:8880/OvCgi/vpo_se
rvice_viewer?[Name 1]

Item Incident Item

Name Show VP for Unix service State

Application Internet Explorer

Parameters http:/VPU_server:8880/OvCgi/vpo_se
rvice_viewer?[Name 1]

Item Service Call

Name Show VP for Unix service State

Application Internet Explorer
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NOTE If you are using smart actions to view service statuses, your 
VantagePoint Web site needs to be entered in the parameters portion of 
the smart action. Normally the Web site will be the same as your 
VantagePoint server.

The following dialog box is an example of a smart action configured to 
show VantagePoint service state for a service call in Service Desk:

Figure 4-12 Show VantagePoint for UNIX Service Status

TIP A number of functions available with this integration use the Smart 
Actions feature in Service Desk. To create a new Smart Action:

1. From the Tools menu, select System, then click Business Logic, 
Actions, then Smart Actions.

2. Click the item that you want to create a smart action for. For 
example; a configuration item or a Service Call.

Parameters http:/VPU_server:8880/OvCgi/vpo_se
rvice_viewer?[Configuration 
Item;Name 1]
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3. Right-click and select New Smart Action from the popup menu.

Additional information on setting up and using Smart Actions can be 
found in the Online Help for Service Desk. 

Manually Send a Message to VantagePoint

Smart actions are available in the demo data for this integration. One 
smart action makes it possible for users to send a message to the 
VantagePoint application to notify the VantagePoint operators that a 
problem is detected. If configured correctly this manually generated 
message will not cause the automatic trouble-ticket interface to generate 
an incident in Service Desk. 

See “Generate a VantagePoint Message from Service Desk” on page  65 
for an example of how this can be configured.

Configuring Service Desk for Outage Planning

You can configure outage planning in Service Desk to send outage 
information to your VantagePoint for Unix server to suppress messages. 

To download outage periods from Service Desk to VantagePoint you will 
need to:

• Install the VantagePoint integration, see “Installation” on page  31.

• Enter occasional planned outages in the work order dialog box for the 
effected CI, (details can be found in the Online Help).

• Enter periodic outages in the Periodic Outage tab in effected CI 
dialog box, (details can be found in the Online Help).

• Create an account for mkoutage.

• Configure a database rule for periodic outages, see “Creating a 
Database Rule for Periodic Outage Information” on page  95.

• Configure a database rule for occasional outages, see “Creating a 
Database Rule for Occasional Outage Information” on page  97.

• Configure the mkoutage.conf file located on your VantagePoint 
server (/opt/OV/SD/bin/mkoutage.conf).
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NOTE For troubleshooting information, see “Mkoutage Outage Planning” on 
page  127.

Create an Account for mkoutage

Create an integration account for mkoutage so that it can access 
information in Service Desk. The account must have access rights to 
view all configuration items and service calls. Limit the access rights of 
this account to prevent the account from being used by a Service Desk 
client.

Creating a Database Rule for Periodic Outage Information

Configuration items are used to register periodic outage information. You 
can configure a database rule to send periodic outage information to 
VantagePoint for Unix as follows:

Figure 4-13 Database Rule Periodic Outages

• When a configuration item is created or modified;

• Where the condition Periodic Outage, OutageEnd; exists:
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Figure 4-14 Conditions for Periodic Outage

Figure 4-15 Action for Periodic Outages

• execute on host: Your VantagePoint for UNIX server

• the command: /opt/OV/SD/bin/mkoutage.sh

• with parameters: -CI:[ID]
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Creating a Database Rule for Occasional Outage Information

The work order item is used to plan occasional outages. You can 
configure a database rule to start mkoutage in VantagePoint for 
occasional outages as follows:

Figure 4-16 Database Rule for Occasional Outages

• When a work order item is created or modified;

• Where the condition: Periodic Outage, Outage End; exists:

Figure 4-17 Conditions for Occasional Outage
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Figure 4-18 Action for Occasional Outages

• execute on host: Your OVO for Unix server

• the command line: /opt/OV/SD/bin/mkoutage.sh

• with parameters: -WO:[ID]
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This section explains the configuration tasks to be done on the 
VantagePoint for UNIX application server.

Modifying the Configurable Extractor File

The file sd_event.ini is a configurable extractor used to extract 
information from VantagePoint. It can be found in the Service Desk 
/opt/OV/SD/bin folder. You will want to update the ACCOUNT and 
SERVER entries in the configuration file, as a minimum. If you change the 
name of the default import mapping, you will need to enter the new 
name in the MAPPING row. A example of the sd_event.ini file follows:

[SD_Event]
LOGFILE=sd_event.log
ERROR_LOGFILE=sd_event_error.log
ACCOUNT=VPU_server1/Password
SERVER=yourserver
PORT=30980
MAPPING=vpunix
CLASSNAME=incident
MODUS=insert
LANGUAGE=GB

Configuring VantagePoint for Outage Planning

The settings for mkoutage are defined in the file: 
/opt/OV/SD/bin/mkoutage.conf. The following table explains what 
needs to be entered in each section of the file:

Table 4-1 mkoutage.conf File

[SD] This section of the file will contain Service Desk 
information.

hostname Enter the host name of the Service Desk application 
server. 
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For information on configuring the Service Desk portion of mkoutage, 
see “Configuring Service Desk for Outage Planning” on page  94. For 
information on using outage planning after it is configured, refer to 
“Suppressing Messages in Service Desk” on page  123, and Outage 
Planning in the Service Desk Online Help.

The Outage Template File

An outage template file is used for managing the outage time periods in 
VantagePoint. This template is updated by the program mkoutage when 
one of the database rules specified for outage planning are triggered. You 
may already have an outage template file on your VantagePoint server. If 
the file exists, you can prevent errors by placing the file in the location 
with the name that is specified in the mkoutage.conf file. If you have 

Username Enter the user name from the account you will be using 
for this portion of the integration. The system account is 
entered by default and should be changed to an 
integration account.

Password Enter the password that goes with the user name for the 
account.

[VPO] This section will contain VantagePoint specific 
information.

outage_templ
ate_file

Enter the file name, including the path where the VPO 
outage template is located. The default is 
/etc/opt/OV/share/conf/OpC/mgmt_sv/respmgrs/ou
tage. It is possible that you already have this template 
at another location. If the template does not exist, you 
will need to create a blank template file at this location 
and with this file name.

reconfigure_r
equest_cmd

This is the VPO command telling the management 
server to process the outage template file. The default is 
opccfgout -update. In most cases it will not require 
modification.

syntax_check
_cmd

This contains the VPO command used to parse the 
outage template file for errors. The default is opcmomchk 
-outage, in most cases it does not need to be modified.

Table 4-1 mkoutage.conf File
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never used outage planning in VantagePoint this file might not exist and 
you will need to create it, by creating a blank text file that matches the 
information specified in the mkoutage.conf file for the 
outage_template_file entry.

An example of an existing outage template file follows:

TIMETEMPLATES
TIMETEMPLATE "timetmpl for Configuration Item 28"
DESCRIPTION "timetmpl for Configuration Item 28"
TIMETMPLCONDS
TIMETMPLCOND
TIMECONDTYPE Match
TIME FROM 07:00 TO 11:00
WEEKDAY ON Saturday
TIMETEMPLATE "timetmpl for Workorder 740"
DESCRIPTION "timetmpl for Workorder 740"
TIMETMPLCONDS
TIMETMPLCOND
TIMECONDTYPE Match
TIME FROM 10:00 TO 11:59
DATE ON 07/29/2001
CONDSTATUSVARS
CONDSTATUSVAR "pckay004" True
CONDSTATUSVAR "ovweb" True

RESPMGRCONFIGS
RESPMGRCONFIG
DESCRIPTION "responsible manager configuration for 
Configuration Item 28"
MSGTARGETRULES
MSGTARGETRULE
DESCRIPTION "message target rule 1 for Configuration Item 28"
MSGTARGETRULECONDS
MSGTARGETRULECOND
DESCRIPTION "message target rule 1 cond for Configuration Item 
28"
CONDSTATUSVAR "pckay004"
SEVERITY Unknown
NODE IP 172.24.1.198 "PCKAYAK P3 900 Mhz "
APPLICATION "PC"
MSGCONDTYPE Match
MSGOPERATIONS
MSGOPERATION
TIMETEMPLATE "timetmpl for Configuration Item 28"
SUPPRESS
RESPMGRCONFIG
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DESCRIPTION "responsible manager configuration for Workorder 
740"
MSGTARGETRULES
MSGTARGETRULE
DESCRIPTION "message target rule 1 for Workorder 740"
MSGTARGETRULECONDS
MSGTARGETRULECOND
DESCRIPTION "message target rule 1 cond for Workorder 740"
CONDSTATUSVAR "ovweb"
SEVERITY Warning
NODE IP 172.24.1.1 "OpenView 3 Webserver "
APPLICATION "ovweb"
MSGCONDTYPE Match
MSGOPERATIONS
MSGOPERATION
TIMETEMPLATE "timetmpl for Workorder 740"
SUPPRESS

Making Service Desk a VantagePoint User

Make Service Desk a VantagePoint user called SD. The commands 
sd_event.sh and sd_eventins.sh create new incidents. These commands 
use the SD user in VantagePoint to gather information from 
VantagePoint. The SD operator in VantagePoint owns the messages as 
soon as they are forwarded to Service Desk, making it possible to 
distinguish VantagePoint messages from other messages in Service 
Desk.

1. From the Window menu in VantagePoint select User bank to 
manually create a user.
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Figure 4-19 Add User dialog box

2. In the Name field enter SD and give it the password sd.

3. Enter Service Desk in the Label, Real Name and Description 
fields.

4. Make the SD user an Operator.

5. Click Responsibilities and select HP-UX to select all 
responsibilities.

6. Click OK when finished.

Moving the Service Desk Application to an Operator

To view Service Desk nodes and incidents from your Java user interface 
you will need to move the applications to the User Bank as follows:

1. Open the VantagePoint User Bank from your Motif user interface.

2. Right-click an operator, for example opc_adm, select Modify, then 
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click Applications.

3. From the Windows menu open the VantagePoint Application Bank 
and select the Service Desk icon.

4. Drag the Service Desk icon to the Applications of User: opc_adm 
dialog box.

5. Click OK in the Modify User opc_adm dialog box.

Modifying the Message Source Templates

The Message Source Templates need to be configured to specify 
conditions for forwarding messages to the Trouble Ticket interface, 
Service Desk. After modifying the Message Source templates you will 
need to redistribute them to your client systems. To adjust the Message 
Source templates from the Motif user interface or the VantagePoint 
server you will need opc_adm administrator rights: 

1. Open Message Source Templates and select Default.

2. Click Group Management Server and then select the items you want 
sent to Service Desk, Bad su (switch user) for example.

3. Click Conditions, select a condition and then the Forward to 
Trouble Ticket check box.

Message Templates need to be distributed to the VantagePoint client 
systems whenever they are updated. To distribute the templates:

1. From the Windows menu, in your VantagePoint Motif or server 
interface, click Node Bank.

2. Select the Server icon.

3. From the Actions menu select Agents then Install/update SW and 
config.

4. Select Templates, Actions, Monitors, and Commands.

5. Click OK. The updated templates will be sent to the client systems.

Deploying the Monitoring Policies 

The monitoring policies installed with this integration need to be 
deployed from your Motif interface to the proper locations after 
installation. The list below shows the policies and where they need to be 
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deployed:

Configuring the Service Desk Agent

The Service Desk agent installed on your VantagePoint for UNIX server 
needs to be configured as follows:

1. Open the file: /sbin/init.d/hpovsdagent.

2. Check the following variables. If they are not accurate modify them:

An example of how this may look in the file follows:
JAVA=/opt/java1.2/bin/java
CLASSPATH=/opt/OV/SD/classes/hpovsdagent.zip:/opt/java1.2
/jre/lib/rt.jar:/opt/OV/SD/classes/mclasses.zip
APPSERVER=sd_server
AGENTUSER=root

SD_VP VantagePoint management server

SD_VP_ACK VantagePoint management server

SD_APP_SERVER_LOG Service Desk server

SD_APP_SERVER Service Desk server

JAVA The absolute path to the java virtual machine.

CLASSPATH The path containing all used classes, including 
those from the Java Runtime environment.

APPSERVER The name of the Service Desk application server.

AGENTUSER The Unix account in which commands are 
executed.
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5 User Tasks

This chapter provides some examples of how this integration can be 
used. Each section contains at least one use case and lists the steps for 
performing the task for VantagePoint for Windows and VantagePoint for 
UNIX as applicable. 
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Importing Nodes into Service Desk
VantagePoint nodes are equivalent to configuration items in Service 
Desk. For Service Desk to relate incidents to a piece of equipment that 
equipment or node needs to be registered as a configuration item. Data 
Exchange is used to automate the process of extracting the node data 
from VantagePoint and import the nodes as configuration items in 
Service Desk. 

VantagePoint for Windows

To export nodes from VantagePoint for Windows and import them as 
configuration items in Service Desk use the Data Exchange task called 
vpwindowsci from the Service Desk application server. For configuration 
information see “Importing Nodes Into Service Desk” on page  49. 

VantagePoint for UNIX

To export nodes from VantagePoint for UNIX and import them as 
configuration items in Service Desk use the Data Exchange task 
vpunixci from the Service Desk application server. For specific 
information see “Importing Nodes Into Service Desk” on page  77.

NOTE Currently Data Exchange cannot detect deleted or outdated nodes. For 
example, you import all nodes into Service Desk as configuration items. 
Six months later 30 of your nodes are replaced by more modern 
equipment. You can reconcile your data exchange data and use the 
change list produced to identify obsolete items. See the Reconciliation 
section in the HP OpenView Service Desk: Data Exchange 
Administrator’s Guide.
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Importing Services and Relations
VantagePoint service information can be imported as configuration items 
into Service Desk using the Data Exchange feature. This makes it 
possible to relate Service Desk incidents to VantagePoint services. 
Dependency and composition relations are also imported. Dependency 
relations are horizontal, for example the purchasing system and the 
human resource department are both dependent on an Oracle database. 
Composition relations are parent-child relations, for example Email 
service is the parent of the US email service and European email 
service. The relations are added to the Related CIs field of the 
configuration item when they are imported.

VantagePoint for Windows

To export nodes from VantagePoint for Windows and import them as 
configuration items in Service Desk use the Data Exchange task called 
vpwindowsservices from the Service Desk application server. For 
specific information see “Importing Services Into Service Desk” on page  
55.

VantagePoint for UNIX

To export Services from VantagePoint for UNIX and import them as 
Configuration Items in Service Desk you will need to save the data in 
ASCII text format and use an ODBC text editor. The complete procedure 
is explained in“Importing VantagePoint for UNIX Services” on page  82.

NOTE An example text file called vp_services_sample.txt is delivered with 
this integration. You can rename it to vp_services.txt.

NOTE To review an additional example of importing data from an ASCII text 
file, see Appendix A, “Examples” in the HP OpenView Service Desk: Data 
Exchange Administrator’s Guide.
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Sending Events From VantagePoint
Service Desk can be used as the Trouble Ticket interface for 
VantagePoint Operations. You can configure VantagePoint to send all 
events or specific events to Service Desk. The event information is 
mapped to a Service Desk incident. The first time an event is sent an 
incident is created in Service Desk. Service Desk is then the owner of 
that event. The import mapping in Service Desk defines which event 
attributes will be imported into the Incident fields.

VantagePoint for Windows

If you are using VantagePoint for Windows you can send event 
information from VantagePoint to Service Desk using the WMI policy 
called Forward messages to Service Desk that intercepts 
OV_Messages and uses a Visual Basic script called Vpw-Sd.vbs to call 
sd_event and forward attributes to Service Desk. SD_event creates a 
corresponding incident in Service Desk. The policy must be deployed on 
the VantagePoint management server.

To send event information from the VantagePoint for Windows 
management console to Service Desk:

1. Configure the integration, see “Deploying the Forwarding Policies” on 
page  70.

2. Once configured, event information that meets the conditions set for 
the policy will automatically be sent to Service Desk. To change what 
message information is sent to Service Desk you will need to modify 
the conditions and distribute the changed policy to your client 
computers. See “Modifying the Forwarding Policy” on page  70.

3. After a message is sent to Service Desk, the severity label will turn 
white to show that it is owned by Service Desk. 

VantagePoint for UNIX

If you are using VantagePoint for UNIX you can send event information 
to Service Desk using the Trouble Ticket interface to call 
sd_eventins.sh. To send event information from the VantagePoint for 
UNIX to Service Desk:
  Chapter 5110
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1. Configure the integration, see “Manually Send a Message to 
VantagePoint” on page  94.

2. Once configured, event information that meets the criteria of the 
message source templates will automatically be sent to Service Desk. 
To change what event information is sent to Service Desk you will 
need to modify the message source templates and distribute them to 
your client computers. See “Modifying the Message Source 
Templates” on page  104.

3. After a message is sent to Service Desk, the severity label will turn 
white to show that it is owned by Service Desk. 
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Reflecting Updates Done in VantagePoint
Changes made to VantagePoint messages from the VantagePoint 
windows management console or the API will be reflected in Service 
Desk. 

VantagePoint for Windows

A WMI policy that registers the event class OV_Message_ChangeEvent is 
used. When a message change occurs, for example severity change, 
message text change, the sd_event program in Service Desk will be 
called to update the corresponding incident.

To reflect updates done in VantagePoint for Windows in your Service 
Desk application:

1. Install and configure the integration.

2. Once the Forward message changes to Service Desk policy is 
distributed, message updates will be sent to Service Desk 
automatically. The import mapping determines what attributes are 
sent to Service Desk.

VantagePoint for UNIX

This feature is not yet available for VantagePoint on UNIX. 
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Manually Forwarding Messages
This feature makes it possible for users to send a message to the Service 
Desk application. A message may need to be manually forwarded when:

• A message is created that was not detected by the automatic fault 
detection application.

• A message is created that is not configured to be sent to Service Desk.

VantagePoint for Windows

This feature is not yet available on VantagePoint for Windows.

VantagePoint for UNIX

VantagePoint or UNIX users can use the Application Bank to manually 
forward messages:

1. Start the Message Browser in the VantagePoint for Motif user 
interface.

2. Select the messages you want to send.

3. From the Actions menu select Start, then Service Desk and click 
Insert Incident. The selected messages will be sent to Service 
Desk.

4. The severity label will turn white when a message is sent to Service 
Desk, showing that Service Desk owns the message. 
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Sending Annotations to VantagePoint
Annotating a message in VantagePoint is similar to adding a note of 
explanation to a business contract. The annotation is a short summation 
of the important points and can be used as a reference the next time you 
receive the same message. Message annotations are normally used to 
provide information on:

• action performed to resolve the problem;

• name of the user who started the action;

• status information for the action performed;

• start and finish time of the action;

• any pre- or post action information which is relevant.

Database rules are available in the demo database for sending an 
annotation to VantagePoint whenever an incident is created as a result 
of an event being sent from VantagePoint to Service Desk. The database 
rule can also be configured to send an annotation to the VantagePoint 
application whenever the status of that incident changes. Database rules 
can be turned on/off and modified from the Service Desk. Agents on the 
VantagePoint server are sent commands, generated from a database rule 
in Service Desk, that call the Vpw-Sd.vbs script (Windows) or 
opcannoadd (UNIX) in VantagePoint.

VantagePoint for Windows

To send annotations to VantagePoint for Windows from Service Desk:

1. Install the demo data and configure the integration, see “Send 
Annotations to VantagePoint for Windows” on page  62.

2. Turn on the database rule, send annotations to VP for Windows: 

• From the Tools menu in Service Desk (server) select System. In 
the Administrators Console navigate to the Business Logic 
folder and open Database Rules. Double-click the Incident item. 

• Annotation rules are available for VantagePoint for Windows and 
VantagePoint for UNIX, make sure you use the correct one. Open 
the rule and use the Database Rule wizard to verify that the 
definition for the rule is accurate and that the rule is not blocked.
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Once the rule is configured and turned on (not blocked) it will 
automatically send annotations to VantagePoint. 

VantagePoint for UNIX

To send annotations to VantagePoint for UNIX from Service Desk:

1. Install the demo data and configure the integration, see “Send 
Annotations to VantagePoint for UNIX” on page  89.

2. Turn on the database rule, send annotations to VP for Unix: 

• From the Tools menu in Service Desk (server) select System. In 
the Administrators Console navigate to the Business Logic 
folder and open Database Rules. Double-click the Incident item. 

• Annotation rules will be visible for VantagePoint for Windows and 
VantagePoint for UNIX, make sure you use the correct one. Open 
the rule and use the Database Rule wizard to verify that the 
definition for the rule is accurate and that the rule is not blocked.

Once the rule is configured and turned on (not blocked) it will 
automatically send annotations to VantagePoint. 
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Sending Acknowledgments to VantagePoint
Acknowledging a message is similar to filing a bill after it is paid. You 
want to retain a copy of the transaction to verify that you have paid the 
bill, and as a reference to compare with future bills. After you have 
finished working with a message you remove it from your desktop and 
file it away for easy future reference. Typically you acknowledge a 
message because:

• You have finished work on the message and resolved any related 
problems.

• You have another message in your Message Browser describing the 
same event.

• You no longer need the message, for example, if the message has low 
severity and requires no action.

Database rules are available in the demo database for acknowledging 
messages from VantagePoint whenever an incident that was created as a 
result of a VantagePoint event is closed in Service Desk. Database rules 
can be turned on/off and modified in the Business Logic section of the 
System Administrator’s Console. Agents on the VantagePoint server are 
sent commands, generated by a database rule in Service Desk, that call 
the Vpw-Sd.vbs script in VantagePoint.

VantagePoint for Windows

To send acknowledgments to VantagePoint for Windows from Service 
Desk:

1. Install the demo database and configure the integration, see “Send 
Acknowledgment to VantagePoint for Windows” on page  60.

2. Turn on the database rule, send acknowledgments to VP for 
Windows: 

• From the Tools menu in Service Desk (server) select System. In 
the Administrators Console navigate to the Business Logic 
folder and open Database Rules. Double-click the Incident item. 

• Acknowledgment rules will be visible for VantagePoint for 
Windows and VantagePoint for UNIX, make sure you use the 
correct one. Open the rule and use the Database Rule wizard to 
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verify that the definition for the rule is accurate and that the rule 
is not blocked.

Once the rule is configured and turned on (not blocked) it will 
automatically send annotations to VantagePoint. 

VantagePoint for UNIX

To send acknowledgments to VantagePoint for UNIX from Service Desk:

1. Install and configure the integration, see “Send Acknowledgment to 
VantagePoint for UNIX” on page  88.

2. Turn on the database rule, send acknowledgments to VP for 
Windows: 

• From the Tools menu in Service Desk (server) select System. In 
the Administrators Console navigate to the Business Logic 
folder and open Database Rules. Double-click the Incident item. 

• If you installed the demo database, acknowledgment rules will be 
visible for VantagePoint for Windows and VantagePoint for UNIX, 
make sure you use the correct one. Open the rule and use the 
Database Rule wizard to verify that the definition for the rule is 
accurate and that the rule is not blocked.

Once the rule is configured and turned on (not blocked) it will 
automatically send acknowledgements to VantagePoint. 
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Viewing Service Desk CIs from VantagePoint
While working in VantagePoint for Windows you can view related 
configuration items in Service Desk. 

The View Node Info action opens the configuration item form in Service 
Desk. The node selected is passed as a parameter using $OPC_NODES. 
The application can only be started with the Windows user interface.

See “Viewing Service Desk CIs from VantagePoint” on page  72 for 
information on how to set up the tool to perform this action in 
VantagePoint.

TIP If the Service Desk dialog box does not open, verify that the Bin folder is 
in the path. For more information see “Setting the Environment Variable 
for Service Desk” on page  47.

VantagePoint for Windows - View Configuration Items

To call the Service Desk user interface when you are working in the 
VantagePoint for Windows management console:

1. Select the node that you want to view as a configuration item in 
Service Desk.

2. Right-click and select All Tasks, then Launch Tool.

3. In the Tool to Execute dialog box select Show Configuration Item 
in Service Desk Client. 

4. Click Launch.
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Viewing VantagePoint Service State 
A browser can be used to view all services that are not working or just 
top level services that are not working, depending on the URL used. The 
services are color coded to show the level of importance: red equals 
critical; orange equals major; yellow equals minor; and light blue (Cyan) 
equals warning. The following scenarios are designed to give you an idea 
of how this feature might be used:

• A support manager wants an update on the state of the top level 
VantagePoint services that are down. The manager clicks the Top VP 
services shortcut on the desktop and gets a view of all top level 
services currently down.

• A specialist is working at a customer site and needs an update on the 
services that are down. The specialist enters the service viewer URL, 
in the browser of a computer with Internet access, and gets a view of 
all services that are down. 

• The customer support center begins to receive numerous calls for 
service. To get a quick overview of services that are currently down 
the help desk engineer uses the Service viewer shortcut on the 
desktop to quickly locate the down service and answer the calls.

VantagePoint on Windows

In Service Desk, add a shortcut to view the overall state of VantagePoint 
services. To create the shortcut:

1. From the Start menu select Programs and then left-click on the 
entry for Service Desk 4.0. 

2. Select Add Shortcut from the popup menu that appears.

3. In the Name field, enter the name you want the shortcut to have and 
select the URL option with the following URL: 
http://server/cgi-bin/ovserviceexport.exe?-format+html[+-
service+service name.]

For viewing top services, remove the service name from the end of the 
URL.

4. Click OK to save the shortcut. 
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5. When you click on the shortcut a hierarchical view of services will be 
visible. Click each service to view more detail information. The view 
will be refreshed every sixty seconds.

VantagePoint on UNIX

There are two Smart Actions available for viewing VantagePoint 
services. Services can be viewed for a service call, an incident, or for a 
configuration item. From the Action menu in Service Desk select: Show 
VP for Unix service state.

Another option is to add a shortcut in Service Desk, to view the overall 
state of VantagePoint for UNIX services. To create the shortcut:

1. From the Start menu select Programs and then left-click on the 
entry for Service Desk 4.0. 

2. Select Add Shortcut from the popup menu that appears.

3. In the Name field, enter the name you want the shortcut to have and 
select the URL option with the following command line: 
http://<server_name>:8880/vpo_top_services.html.
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Figure 5-1 Create a Shortcut to View Top VantagePoint Services

4. Click OK to save the shortcut. 

5. When you click on the shortcut a hierarchical view of services will be 
visible. Click each service to view more detail information. The view 
will be refreshed every sixty seconds.
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Generating a VantagePoint Message From 
Service Desk
If a helpdesk employee becomes aware of a problem in the IT 
infrastructure and creates an incident in Service Desk. However, an 
error message does not exist for the problem in the VantagePoint 
application. The helpdesk employee, can use a smart action in Service 
Desk to pass the incident information to the VantagePoint application, 
creating a new error message in VantagePoint. 

VantagePoint for Windows

To generate a VantagePoint message from the Service Desk user 
interface:

1. Select or open an incident in Service Desk.

2. From the Actions menu in Service Desk click the Generate VP 
message manually action.

3. A new message will be created in VantagePoint.

VantagePoint for UNIX

To generate a VantagePoint message from the Service Desk user 
interface:

1. Select or open an incident in Service Desk.

2. From the Actions menu in Service Desk click the Generate VP 
message manually action.

3. A new message will be created in VantagePoint.
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Suppressing Messages in Service Desk
You can suppress node-down messages that are sent to Service Desk 
from a VantagePoint for UNIX server by using mkoutage to download 
outage information. Two types of outages are recognized: periodic, or 
recurring outages, and occasional, or incidental outages. Outage 
planning is administrative task in Service Desk, it can only be used to 
suppress messages when installed with the VantagePoint integration.

NOTE It is not possible to automatically detect if outage periods manually 
entered on your VantagePoint server application conflict with outage 
periods sent from Service Desk. If a conflict occurs, the result may be an 
error in the outage time period in the VantagePoint application.

NOTE Outages planned for a Service Level Agreement in Service Desk cannot 
be downloaded into VantagePoint. 
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Monitoring Service Desk Processes
VantagePoint log file policies can be used to monitor the log files for the 
agent (UNIX only), sd_event, and the Service Desk application server. 
This provides you with a means for monitoring the integration 
continuously. The policies can be used to match specific log file lines and 
assign variables out of the intercepted lines to use for pattern matching.

VantagePoint for Windows

Once the policies are deployed, detected errors are sent to the message 
browser automatically. Instructional text is provided with the error 
messages to help solve detected problems. The policy monitor sd_event 
logfile is used to monitor the VantagePoint management server. The 
policy Monitor Service Desk logfile is available for monitoring the 
Service Desk application server.

VantagePoint for UNIX

Once the policies are deployed, detected errors are sent to the message 
browser automatically. SD_VP and SD_VP_ACK must be deployed on the 
VantagePoint application server. SD_APP_SERVER_LOG and 
SD_APP_SERVER must be deployed on the Service Desk application server. 
Instructional text is provided with the error messages to help solve 
detected problems.

SD_VP For monitoring the 
VantagePoint management 
server (sd_event_error.log). 

SD_VP_ACK For monitoring the Service 
Desk agent on the 
VantagePoint management 
server (hpovsdagent.log).

SD_APP_SERVER_LOG For monitoring the Service 
Desk application server 
(logserver.txt). 

SD_APP_SERVER For monitoring the Service 
Desk application server.
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6 Troubleshooting

This chapter contains troubleshooting information for using the 
VantagePoint operation for UNIX or Windows with Service Desk.
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Troubleshooting Information
This section contains information that may be helpful in locating and 
solving errors that occur when using this integration.

Potential Windows Error Messages

This section explains error messages you may encounter in 
sd_event_error.log, followed by a possible solution.

Viewing Items Error

Error message: You are not allowed to view this type of item.

Solution:

1. From the Tools menu in Service Desk, click System, then Security, 
then Access, and Role.

2. Open the Helpdesk role and select View access for the Account 
item.

3. Click OK and then restart the Service Desk application server.

Server Response Error

Error message in sd_event_error.log.
SERVER RESPONSE=ERROR: null criteriu

Solution: This error occurs when the VantagePoint message can not be 
accessed by the get_vp_attributes command. Verify that you have 
added Service Desk (SD) as a user in VantagePoint with the correct 
password and that the Service Desk user has access to messages. 

UNIX Log Files

• The file /var/opt/OV/SD/log/applog.txt shows when the Service 
Desk agent was started. 

• The file /var/opt/OV/SD/log/hpovsdagent.txt contains output 
and errors from the Service Desk agent.

• The file /opt/OV/SD/bin/sd_event_error.log contains errors 
regarding the automatic and manual forwarding of events to Service 
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Desk.

Acknowledgments and Annotations on VantagePoint 
for UNIX

This section contains some troubleshooting tips to help you resolve errors 
that may occur in the acknowledgment and annotation portions of this 
integration.

From the Tools menu in Service Desk, select System, then click 
Business Logic, then Database Rules. Open the Incident item to 
view the database rule. Verify that the:

• rule is not blocked;

• conditions are met;

• action is not blocked.

On your VantagePoint for Unix server verify that your agent files are 
installed as follows:

• /sbin/init.d/hpovsdagent

• /opt/OV/SD/classes/hpovsdagent.zip

• /opt/OV/SD/classes/mclasses.zip

Verify that the agent is running: /sbin/init.d/hpovsdagent status.

Check for errors in the log file: /var/opt/OV/SD/log/*.log

Mkoutage Outage Planning

To begin troubleshooting mkoutage you might want to look for possible 
causes in the log file, mkoutage.log located in /opt/OV/SD/bin. If that is 
unsuccessful you can continue the troubleshooting or testing by starting 
mkoutage manually as described in the following paragraphs:

You can start the Mkoutage utility used for outage planning manually 
from the command line, for testing or troubleshooting. To start it, run 
mkoutage.sh with either the -ci or -wo flag followed by the ID for the 
item. Configuration items (-ci) are used for periodic outages, work orders 
(-wo) for occasional outages.

This command will connect mkoutage to the Service Desk application 
server, where it will examine the outage data specified for the item 
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entered in the command line. If sufficient information is available, it will 
create a new template entry and attempt to add it to the template file, 
then send a request to the VantagePoint server to process the file again.

If the template entry is successfully added, mkoutage will remove all 
obsolete template entries in the template sections it controls that have 
end dates before the current date and time. This is done to control the 
size of the template. Mkoutage will only delete entries in the sections 
that are surrounded by the comments:
"#SD_TIMETEMPLATES_START" , "#SD_TIMETEMPLATES_END", 
"#SD_RESPMGRCFGS_START", and "#SD_RESPMGRCFGS_END"

Tips for Demonstrations and Testing

This section contains information that can be used when testing or 
demonstrating the integration in a non-production environment. For 
VantagePoint for UNIX users some example services are available and 
this section lists commands that can be used to list and assign access to 
the services:

• Add the sample services for demonstration purposes:
# opcservice -add 
/opt/OV/OpC/examples/services/banking.xml
# opcservice -add /opt/OV/OpC/examples/services/sap.xml

• List of top services:
# opcservice -list

• List of all services:
# opcservice -list -sub

• Assign an operator to a service tree. This enables the operator to view 
the assigned services in the Java user interface. The example below 
will assign the banking services:
# opcservice -assign opc_op banking

• Show the services that users have access to:
# opcservice -operators

Integration Item Reference List

The following tables are provided to give you an overview of the various 
files and configured items included in this integration and their use. The 
tables include the various import mappings, configuration files, 
applications (UNIX), policies, database rules, smart actions and other 
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key tools provided with this integration:

Table 6-1 Configuration (ini) Files

Name Use

sd_event.ini For importing events into 
Service Desk.

vpwindowci.ini For importing VPO for 
Windows nodes as 
configuration items into Service 
Desk.

vpunixci.ini For importing VPO for UNIX 
nodes as configuration items 
into Service Desk.

vpwindowsservices.ini For importing services from 
VPO for Windows into Service 
Desk.

vpunixservices.ini For importing services from 
VPO for UNIX into Service 
Desk.

Table 6-2 Import Mapping

Name Use

sd_event For mapping VPO events to 
Service Desk (Incident) item 
and attributes.

vpwindowci For mapping VPO for Windows 
nodes to configuration item and 
attributes in Service Desk.

vpunixci For mapping VPO for UNIX 
nodes to configuration item and 
attributes in Service Desk.

vpwindowsservices For mapping services from VPO 
for Windows to Service Desk 
configuration items.
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vpunixservices For mapping services from VPO 
for UNIX to Service Desk 
configuration items.

Table 6-3 Applications in VPO for UNIX

Name Use

Insert Incident For inserting error messages 
from VantagePoint for UNIX 
into Service Desk as an 
incident.

View Incident Info For viewing incidents in 
Service Desk that are related to 
VPO for UNIX messages. 

View Node For viewing configuration items 
in Service Desk that are related 
to VPO for UNIX nodes.

Table 6-4 Database Rules in Service Desk

Name Use

Send acknowledgments to VP 
for Unix.

For sending an 
acknowledgement to 
VantagePoint for UNIX.

Send acknowledgments to VP 
for Windows

For sending an 
acknowledgements to 
VantagePoint for Windows.

Send annotations to VP for 
Unix.

For sending annotations to VP 
for UNIX.

Send annotations to VP for 
Windows.

For sending annotations to VP 
for Windows.

Table 6-2 Import Mapping

Name Use
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Table 6-5 Smart Actions in Service Desk

Name Use

Generate VP message manually To manually insert a Service 
Desk incident as a message in 
VPO for UNIX.

Show VP for Unix service 
state

To view the state of 
VantagePoint for UNIX services 
with a Web browser.

Show VP for Windows service 
state

To view the state of 
VantagePoint for Windows 
services with a Web browser.

Table 6-6 Policies in VPO for Windows

Name Use

Forward messages to Service 
Desk

To forward a message from 
VantagePoint to Service Desk.

Forward message changes to 
Service Desk

To forward message changes 
from VantagePoint to Service 
Desk.

Monitor Service Desk log file To monitor the Service Desk log 
file for errors.

Monitor sd_event log file To monitor the sd_event log file 
for errors.

Table 6-7 Tools in VPO for Windows

Name Use

Show Configuration Item in 
Service Desk Client

To view the configuration item 
in Service Desk that is related 
to the node selected in 
VantagePoint.
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Table 6-8 Accounts in Service Desk

Name Use

VPW_server1/servicedesk Default account created for the 
VantagePoint for Windows 
server. Server accounts must 
start with VPW or VPU.

VPU_server1/servicedesk Default account created for the 
VantagePoint for UNIX server. 
Server accounts must start 
with VPW or VPU.

Table 6-9 Monitoring Files in VPO for UNIX

Name Use

SD_VP For monitoring sd_event on 
the VantagePoint management 
server.

SD_VP_ACK For monitoring the Service 
Desk agent on the 
VantagePoint management 
server

SD_APP_SERVER_LOG For monitoring the Service 
Desk application server.

SD_APP_SERVER For monitoring the Service 
Desk application server.

sd_access.exe Used by SD_APP_SERVER to 
check if access is authorized.

Table 6-10 Monitoring Policies in VPO for Windows

Name Use

Monitor sd_event logfile For monitoring sd_event on the 
VantagePoint management 
server.
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Installation Reference Tables

Monitoring Service Desk 
Logfile

For monitoring the Service Desk 
application server.

Table 6-10 Monitoring Policies in VPO for Windows

Name Use

Table 6-11 Service Desk Server

File Default Location

vpunixci.ini and 
vpwindowsci.ini

Service Desk product 
path\data_exchange\config

vpunixservices.ini and
vpwindowsservices.ini

Service Desk product 
path\data_exchange\config

sd_access.exe Service Desk product path\bin

vp_mappings.sql runs in repository account to add 
import mapping to database.

Table 6-12 VantagePoint Server - Windows Platform

File Default Location

sd_event.exe VantagePoint Product 
Path\bin\tools

sd_event.ini VantagePoint Product 
Path\bin\tools

Vpw-Sd.vbs VantagePoint Product 
Path\bin\tools

queuectl.exe
enqueue.exe
dequeue.exe

VantagePoint Product 
Path\bin\tools

Monitor Service Desk logfile 
(policy)

VPW database
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Monitor sd_event logfile 
(policy)

VPW database

Forward messages to Service 
Desk (policy)

VPW database

Forward message changes to 
Service Desk (policy)

VPW database

Table 6-13 VantagePoint Server - UNIX Platform

File Default Location

sd_event.ini /opt/OV/SD/bin

sd_event /opt/OV/SD/bin

sd_event.sh in Trouble 
Ticket Interface

VantagePoint database

sd_event.sh /opt/OV/bin/OpC/extern_intf

sd_eventins.sh /opt/OV/bin/OpC/extern_intf

sd_eventins.pl /opt/OV/bin/OpC/extern_intf

get_vp_attributes /opt/OV/bin/OpC/extern_intf

Table 6-12 VantagePoint Server - Windows Platform

File Default Location
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